
 
 

ACADAMIC CELL, NPS GDC Women(A) 
Chittoor  

Proceedings of the Principal, NPS Govt. Degree College for Women(A), Chittoor 
Present: Dr. K. Manohar 

 
Rc.No. COM/BFS/ 01 /NPSGDCW/UG-BoS/2025-26 dt. 28-09-2025 

 
         Subject:  NPS GDC Women(A), Chittoor – UG Board of Studies (BoS) –   Nomination of Members –          
                          Orders issued.  
         Ref.: 1. UGC Guidelines of for Autonomous Colleges – 2023. 
                  2. Proc. of the VC No: SVU/C-III (3)/BoS/Smt. N.P.S. Govt. Coll/chi/2025 

*** 
 Order 

 
The Principal, NPS GDC Women(A) pleased to inform that to conduct Board of Studies Members 

meeting in the subject of commerce B.Com BFSI for the academic years 2025-26 to  2027-28 to the 
concerned course or till the date of your retirement / transfer whichever is earlier. Following the norms of 

the UGC Regulations, 2023. 

 A copy of the list of members of the Board of Studies of Commerce is herewith enclosed for your 

information. Your acceptance is a pleasure to serve in the board and the college expects your valuable 
advice / suggestions during the above period. 

S.NO Name & Designation Chairperson/ Member Signature 

1 Dr. T.Vinila Chairperson  

2 Prof.P.Mohan  Reddy University Nominee   

3 Prof.Raghunadha Reddy University Nominee  

4 Dr.K.Nandeeswaraiah Subject experts by University  

5 Dr.V.Maslamani Subject expert   

6 Dr.k.Sankar Reddy Subject expert   

7 Sri.A.M.Narendra kumar Industrialist  

8 Dr.J.Ramadevi Member  

9 2.N.Kasturamma Member  

10 G.Yamuna Alumni  

 
The above members are requested to attend the BoS meeting for the first autonomous UG-Batch 2025-26 

and share their valuable, Suggestion on the following functionaries. 

 Prepare the syllabi for the subject keeping in view the objectives of the College, interest of the 

stakeholders and national recruitment for consideration and approval of the IQAC and Academic 
Cell. 

 Suggest methodologies for innovative teaching and evaluation techniques. 

 Suggest the panel of names to the Academic Council for appointment of Examiners 

 Coordinate research, teaching, extension and other activities in the department and the college. 

 Suggest CLO,PLO, and subject experts to develop question bank in compliance with bloom’s 

 Taxamony 

The above said members are requested to bestow their services for the successful organization of the 

events whenever scheduled. 

                                                                                                                                    
                                                                                                                                 Principal 



 
 

 

Department of Commerce & Management 
BOARD OF STUDIES MEMBERS ACADEMIC YEAR 2025-2026 t0 2027-28 

 
            

 
                       

 

 

 

 

 

 

 

 

 
            

 
                       

 

 

 

 

 

 

 

 

S.NO                  

Category 

Name & Designation Chairperson/ Member 

1 Chairperson Dr. T.VINILA 

Lecturer in Commerce 

Smt.N.P.S GDC For 

women(A) Chitoor. 

Faculty 

Mobile: 8897799816 

thadipallivinila@gmail.com 

2 Members of the 

Department 

 

1.Dr.J.Ramadevi 

Lecturer in Commerce 

2.N.Kasturamma 

Lecturer in Commerce 

 

Members 

Mobile: 9177639191 

Email: jaanujeswi@gmail.com 

Mobile:9492067954 

Email: kasturamma05@gmail.com 

3 One expert from 

to be nominated by 

the Vice-

Chancellor 

Prof.P.Mohan  Reddy 

Dept.of Commerce 

SVU College of CM & 

CS 

Tirupathi 

University Nominee 
Mobile:9849063909 

Email:dr.pmohanreddy@gmail.com 

4 One  Experts in the 

Subject nominated 

by 

Vice-Chancellor   

Prof.Raghunadha 

Reddy 

Dept.of Management 

SVU College of CM & 

CS 

Tirupathi 

University Nominee 

Mobile:9346234167 

Email:dr.reddy@gmail.com 

5 One  Experts in the 

Subject from 

outside the college 

to be nominated by 

University 

Dr.K.Nandeeswaraiah 

Lecturer in Commerce 

SVCR Govt. Degree 

College 

Palamaner 

Subject experts by University 

Mobile:9440396477 

Emai:knadeeswae@gmail.com 

6 Two Experts in the 

Subject from 

outside the college 

to be nominated by 

Academic council 

1.Dr.V.Maslamani 

Lecturer in Commerce 

GDC Pakala 

Tirupathi dt. 

2.Dr.k.Sankar Reddy 

Lecturer in commerce 

GDC,Vedurukuppam. 

Mobile:9290198731 

Email id:vm4606@gmail.com 

 

 

Mobile: 9866415051 

Email id :sankar.nali@gmail.com 

 

 

 

mailto:jaanujeswi@gmail.com


 
 

                                                                 

    

            Signature of the chairperson         Signature of the BOS Members 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

7 

 

Representative 

from the Industry/ 

Corporate Sector 

A.M.Narendra kumar 

District Tourism Officer 

Chittoor 

Mobile: 9441392480 

Email: 

amnarendrakumar@gmail.com 

8 One Meritorious 

Alumnus 
G.Yamuna 

Guest faculty  in 

Commerce 

Smt.N.P.S GDC For 

women(A) Chittoor 

 

Mobile: 9502377593 

Email 

id:yamunabujji1984@gmail.com 



 
 

 
 

Department of Commerce 

ACADEMIC YEAR  2025-2026 

                                                       UG B.COM BFSI HONOURS  

                                                      
BOARD OF STUDIES MEMBERS 

MINUTES OF THE MEETING 

 

The 1st meeting of BOS in Commerce to be held on 30-10 -2025 at 11.00AM 

 

      Agenda: 

1. To discuss 

2. Approval for UG B.Com BFSI Course structure of Commerce 

3. Approval for changes in the UG B.COM BFSI I Semester paper entitled Business & 

Applied law, Business economics, Banking Theory and Practices and Accounts Assistant 

as skill paper and II Semester Taxation, Branch Banking Operations, Social Media 

marketing and advertising and GST as skill course. Model question paper and blue print. 

4. Panel of question paper setters and examiners. 

5. Pedagogy of Teaching – learning as per UGC guidelines 

6. Additional Inputs to the Curriculum 

7. Internal assessment component and additional credits for extra - curricular activities. 

8. Evaluation and assessment pattern. 

9. Introduction of new certificate and diploma courses 

10. Other academic and extra-curricular activities of the department 

11. Any other proposal with permission of the chair. 

 

     Signature of the Chairman               Signature of the BOS Members                                                                                                                                                     

          

 

 

 

 

 

 

 

 



 
 

 
Department of Commerce  

ACADEMIC YEAR  2025-2026 

                                                           UG B.COM BFSI HONOURS  

 

Resolution of the BoS Meeting for I &II Semesters 

 
In the present BOS meeting the following resolutions were made and unanimously approved by 

the committee. The decisions / changes wherever necessary, taken at college level may be 

adopted in the consecutive academic years on the date of BOS meeting conducted 30-10-2025, 

11:30 am. 

 Resolutions of the Meeting :  

   It is resolved unanimously 

 
1. The college was conferred with autonomy by the UGC in the month 04-09-2024. 

Subsequently, the college submitted letters to the parent university(SVU), UGC and to the Govt. 

of AP for constitution of Statutory Bodies and release of notification by the affiliating university. 

The Registrar, S.V. University issued notification and directed to implement autonomy from the 

academic year 2025-26. The college prepared its own academic schedule after the conferment of 

autonomy. Accordingly, the college has been implementing autonomy for I year degree I & II 

semester students from the date of issuance of notification on adhoc basis following the 

academic regulations of the parent university and covered the prescribed syllabus in the first 

semester by making certain changes. The syllabus, course structure, model question papers and 

blue print are placed before the committee for ratification. 

2. As per the academic schedule for I semester of I year students was started on 22-09-2025 and 

the academic instruction has been given to the students as per the syllabus designed by the 

internal BOS members. It is placed before the committee for constructive suggestions for 



 
 

further improvement keeping in view the local needs / market demand / industry-needs / 

employment generation as per the UGC Regulations 2023. 

 

3. Resolved to ratify the panel of question paper setters nominated for UG I year semester I 

Examinations. 

4. Resolved to follow the pedagogy of teaching / learning strategies as per the UGC 

guidelines. 

5. Resolved to use additional inputs to enrich the curriculum and enlighten the students on 

academic performance. 

6. To include internal assessment components and additional credits for extracurricular 

activities of the students. 

7. To follow the evaluation and assessment pattern strictly adhering the UGC norms and 

guidelines. 

8. To introduce new certificate and diploma courses related to subject and other courses 

deemed to be useful for the students. 

9. To take the valuable suggestions of the BOS on academic and extra-curricular activities 

to be taken up at department level for strengthening the academic instruction to the students. 

10. If any discussion related to academic matters including extracurricular activities may be 

included as the last resolution. 

 

Signature of the BoS Chairman                   Signature of the BOS Members 

         

 

 

 

 

 

 

 

 

 



 
 

Department of Commerce 
FOR UG B.COM BFSI HONOURS 

ACADEMIC YEAR 2025-2026 

APSCHE COURSE STRUCTURE 

 

 

 

 



 
 

 

 

 

 

 

 

 

 

 

 



 
 

 

                                  Department of Commerce 

FOR UG B.COM BFSI HONOURS 
ACADEMIC YEAR 2025-2026 

 

Sl. No Course Codes Course Internal External Max. Marks hrs  Credits 

1 25BFS101T Business & Applied Law 30 70 100 4 4 

2 25BFS102T Business Economics 30 70 100 4 4 

3 25BFS103T Banking theory  and Practice 30 70 100 4 4 

4 25BFS101S Account Assistant  30 70 100 6 4 

5 25BCS101S 

25BCS101L 

Artificial Intelligence 30 70 100 6 4 

 

PSO1 
Ability to understand practical applications of Banking ,Insurance and Financial 

Services theories. 

PSO2 To impart knowledge regarding the component so Indian Financial System 

PSO3 
To provide in depth understanding of different a venues of financial system viz. 

Capital markets, banking, insurance, mutual funds & other related services. 

PSO4 
To enable the students to understand the role & functioning of regulatory bodies in 

Financial Sector 

PSO5 
To equip the students with skills required to operate in competitive environment in 

the Financial Service Sector. 

 

 

 



 
 

 

I B. Com HONOURS IN BANKING FINANCIAL SERVICES & INSURANCE 

SEMESTER –I: COMMERCE PAPER – I 

BUSINESS AND APPLIED LAW 

 

      Credits: 04                 course code : 25BFS101T           Teaching Hrs/Week : 4 

 

 

____________________________________________________________________________ 

SYLLABUS 

Course Objectives:  

 To provide a comprehensive understanding of applied Indian business laws,  

 To appraise the merits and demerits of legal compliance, and ethical decision-making. 

UNIT:1 INTRODUCTION TO INDIAN BUSINESS LAW  

Overview of the Indian legal system-Sources of Business Law- - key legal concepts of Indian 

legal laws - Role of Law in Business- Indian Contract Act, 1872: Principles of Indian Contract 

Act - Essentials of valid contract. 

UNIT: 2 REGULATORY FRAMEWORK FOR BUSINESS IN INDIA 

Role of regulatory agencies: Securities Exchange Board of India-Reserve Bank of India- 

Insurance Regulatory and Development Authority – Negotiable Instruments Act, 1881. 

UNIT: 3 CORPORATE LAWS AND BUSINESS ORGANIZATIONS 

Companies Act 2013: Incorporation and registration of companies - governance requirements for 

Indian companies - Partnership Act: Formation and types of Partnerships- Rights and Duties of 

partners- Dissolution of partnerships Limited Liability Partnerships (LLPs): Formation and 

Registration of LLPs   

UNIT: 4 INTELLECTUAL PROPERTY RIGHTS (IPR) IN INDIA  

Intellectual Property Laws in India: Indian Patents Act, 1970- Trademarks Act, 1999 - Copyright 

Act, 1957 - Geographical Indications (GI) protection 

UNIT: 5 EMERGING AREAS IN INDIAN BUSINESS LAW  



 
 

Start-up and Entrepreneurship Laws: Legal framework for start-ups in India- Incentives and 

support mechanisms for start-ups- Overview of e-commerce laws and electronic contracts 

REFEENCES: TEXT BOOKS: 

 Elements of Business Law By N D Kapoor 

 Business Law For Management By Bulchandani 

 Company Law By Avtar Singh 
 

 

 

SUGGESTED READINGS:  

1. Arora Sushma– Business Law– Taxmann Publication 

2. Business Laws: Das & Roy, Oxford University Press  

3. Tulsian, P.C, Business Law, S.Chand.  

4. Maheshwari & Maheshwari, Business Law, National Publishing House, New Delhi. 

5. Legal journals  

6. Legal databases and online resources (Manupatra, SCC Online) 

 

 

 

                                                              *************** 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 



 
 

 
 

I B. Com HONOURS IN BANKING FINANCIAL SERVICES & INSURANCE 

SEMESTER –I: COMMERCE PAPER – I 

BUSINESS AND APPLIED LAW 

 

 

Subject: Business and Applied Law                                 Code: 25BFS101T 

BLUE PRINT FOR THE MODEL PAPER 

 

 

S. 

NO  
 

 

Type of 

Question  
 

 

To be given in the Question Paper  
 

 

To be answered 
 

No. of 

Questions 
 

Marks 

allotted 

to each 

question  
 

Total 

Marks  
 

No. of 

Questions  
 

Marks 

allotted 

to each 

question  
 

Total 

Marks  
 

2 Section - A 

(Short 

Questions) 

10 5 50 5 4 20 

3 Section – B 

(Essay 

Questions) 

10 10 100 5 10 50 

Total Marks 

 

150 Total Marks 70 

 

 

 

 

 

 

 



 
 

 
 

I B. Com HONOURS IN BANKING FINANCIAL SERVICES & INSURANCE 

SEMESTER –I: COMMERCE PAPER – I 

BUSINESS AND APPLIED LAW 

 

 

Subject: Business and Applied Law                                 Code: 25BFS101T 

 

BLUE PRINT FOR THE QUESTION PAPER SETTING 

 

Chapter Name   
 

Short questions 

5 marks   

Essay questions  10 

marks  

 

UNIT – I 2 2 

UNIT – II 2 2 

UNIT – III 2 2 

UNIT – IV 2 2 

UNIT – V 2 2 

Total No. of Questions  

 

10 10 

 

 

Signature of the Chairman             Signature of the BOS Members 

              

 

 

 

 

 

 

 

 

 

 



 
 

 

 
 

I B. Com HONOURS IN BANKING FINANCIAL SERVICES & INSURANCE 

SEMESTER –I: COMMERCE PAPER – I  

BUSINESS & APPLIED LAW 

 

 Time :3hrs    Code: 25BFS101T                            Max Marks : 70 

______________________________________________________________________________ 

MODEL QUESTION PAPER 

SECTION – A 

Answer any Five of the following Questions     5X4 =20 Marks 

1. Valid Contract 

2. Negotiable Instruments Act 

3. Partnership Deed 

4. Trade Marks 

5. E-Commerce Laws 

6. IRDA 

7. SEBI 

8. Startups 

9. Intellectual Rights 

10. Companies Act-2013 

 

SECTION – B 

   Answer any ONE question from each UNIT:                                                             (5 × 10 = 50 Marks) 

UNIT – I 

11.Explain the essential elements of a valid contract. 
  OR 
12.Role of Law in Business. 
 
UNIT – II 
13.Explain the role of RBI. 
  OR 
14.Write about the powers of SEBI. 
 
UNIT – III 
15.Types of partners. 
  OR 



 
 

16.Limited Liability Partnership. 
 

UNIT – IV 
17.Discuss about IRDA. 
  OR 
18.Incentives and support mechanisms for start-ups. 
 

UNIT – V 
19.Discuss about the Copyright Act, 1957 and the Indian Patents Act, 1970. 
  OR 
20.Overview of E-Commerce Laws and Electronic Contracts. 
 
                                                                                                                                                                                                     
Signature of the BOS Chairman                                                                      Signature of the  Members 
 



 

 

 

 

 
I B. Com HONOURS IN BANKING FINANCIAL SERVICES & INSURANCE 

SEMESTER –I: COMMERCE PAPER – II 

                                                       BUSINESS ECONOMICS 

 

                                                                                                                 25BFS102T 

 

Name of the Programme  :B.Com 

 

Name of the Specific Programme : BFSI (Honors) 

 (Group) 

Semester    :  I 

 

Name of the Course (Paper)  :  Business Economics 

 

Paper Code    :  25BFS102T 

 

Course Outcomes   :At the end of the course students able to 

 

CO1 To understanding economic principles and fundamental economic concepts 

relevant to business decisions 

CO2 To understanding factors influencing demand and supply and their implications for 
pricing and production  

CO3 
To develop skills in evaluating the costs and market competitions  

CO4 
To create awareness of global economic factors and their influence on domestic 

business operations 

        

                                                                                     Signature of the  BOS Members 

1. 

2. 

3. 

4. 

5. 

 



 

 

 

 

I B. Com HONOURS IN BANKING FINANCIAL SERVICES & INSURANCE 

SEMESTER –I: COMMERCE PAPER – II 

BUSINESS ECONOMICS 

 Credits: 04              25BFS102T                      Teaching Hrs/Week : 4 

   

SYLLABUS 

Course Objectives: 

 To understand the basic micro and macro-economic concepts and Theories applicable 

to business decision-making. 

 To appraise the importance of economic approaches in business decision – making. 

 

UNIT–I: Introduction to Business Economics 

Definition and scope of Business Economics- Circular Flow of Activity - Nature of the 

Firm - Objectives of Firms -Nature of Economic Laws – Methods of Economic 

Enquiry – Meaning of Micro and Macro Economics – Fundamental Concepts – Wants 

– Utility- Value - Wealth- Welfare. 

 

UNIT-II: Demand& Supply Analysis  

Meaning of Demand - Types of Demand – Determinants of Demand – Law of Demand – 

Marginal Utility Analysis – Elasticity of Demand – Consumer’s Surplus - Supply Analysis – 

Meaning - Factors of Production - Land, Labour Capital and Organization – Law of Returns – 

Production Function – Return to Scale 

 

UNIT- III: Cost and Output Analysis 

Different Cost concepts–Marginal and Average Cost–Relationship– Long run and Short run 

cost curves–Revenue curves of firms. Market Structure – Perfect Competition – Monopoly – 

Monopolistic Competition –Duopoly – Oligopoly 

 

UNIT- IV: National Income  

 Concepts – Measurement of National Income – Business Cycles: Various Phases – Important 

implications for Business – Appropriate Strategies and Policies both at the Macro and Micro 

Levels. 



 

 

UNIT –V: Globalisation 

Implication to the Indian Economy–Theory of International Trade – Balance of Trade – 

Balance of Payments: Current Situation and Future Prospects.- Foreign Exchange Markets 

and Exchange Rate Determination - Factors influencing exchange rates. 

References:  

1. Varshney R.L.&Maheswari,Managerial Economics 

2. Joel Dean, Managerial Economics 

3. Mithani and VSR.Murthy, Fundamentals of Business 

Economics  

 

                     

 

 

 
 

I B. Com HONOURS IN BANKING FINANCIAL SERVICES & INSURANCE 

SEMESTER –I: COMMERCE PAPER – II 

BUSINESS ECONOMICS 

 

 

BLUE PRINT FOR THE MODEL PAPER 

 

 

S. 

NO  
 

 

Type of 

Question  
 

 

To be given in the Question Paper  
 

 

To be answered 
 

No. of 

Question 
 

Marks 

allotted to 

each 

question 
 

Total 

Marks  
 

No. of 

Questions  
 

Marks 

allotted 

to each 

question  
 

Total 

Marks  
 

1 

 

Section - A 

(Short 

Questions) 

10 5 50 5 4 20 

2 Section - B 

(Essay 

Questions) 

10 10 100 5 10 50 

Total Marks 

 

150 Total Marks 70 

 

 

 

 

25BFS102T 



 

 

 

 
I B. Com HONOURS IN BANKING FINANCIAL SERVICES & INSURANCE 

SEMESTER –I: COMMERCE PAPER –II 

BUSINESS ECONOMICS 

                                                               Code: 25BFS101T 

 

BLUE PRINT FOR THE QUESTION PAPER SETTING 

 

Chapter Name   
 

Short questions 

5 marks   

Essay questions  10 

marks  
 

UNIT – I 2 2 

UNIT – II 2 2 

UNIT – III 2 2 

UNIT – IV 2 2 

UNIT – V 2 2 

Total No. of Questions  

 

10 10 

 

 

Signature of the Chairman   Signature of the BOS Members  

            

 

 

 

 

 

 

 

 

 

 

 

 

 

 



 

 

                                      
 

I B. Com HONOURS IN BANKING FINANCIAL SERVICES & INSURANCE 

 SEMESTER –I: COMMERCE PAPER – II 

BUSINESS ECONOMICS 

Time :3hrs         Max Marks : 70 

___________________________________________________________________________ 

MODEL QUESTION PAPER 

 

Time : 3Hrs         Max. Marks : 70 

==================================================================================================== 

PART – A 

I. Answer any Five from the following Questions.                                   (5 x 4 = 20 ) 

1. Define Business Economics and explain its scope. 

2. What do you mean by the Circular Flow of Economic Activity? 

3. Difference between Microeconomics and Macroeconomics. 

4. What are the main determinants of demand? 

5. State the Law of Demand and explain its exceptions. 

6. Define Elasticity of Demand. What are its types? 

7. Explain the concept of Marginal and Average Cost. 

8. What are the characteristics of Perfect Competition? 

9. Define National Income and explain its importance. 

10. Write a short note on Balance of Payments 

PART – B 

 

II. Answer one question from each unit of the following Questions (internal choice).                 

                                                                                                                (5 x 10 = 50 ) 
UNIT - I 

Define Business Economics. Discuss its nature, scope, and importance. 
 
(OR ) 

 

      12. Explain the objectives of firms and discuss the nature of economic laws and methods of  
            economic enquiry.  

UNIT - II 
 
     13. What is demand? Explain the Law of Demand and the factors determining demand for a  



 

 

            commodity. 
(OR ) 

 

     14. Discuss Elasticity of Demand and explain the concept of Consumer’s Surplus. Also            
           describe the Law of Returns. 
 

UNIT - III 
 
15. Explain the different cost concepts and show the relationship between marginal cost and  
         Average cost with diagrams. 
                                                            (OR ) 
 
16.  Discuss the different types of market structures – Perfect Competition, Monopoly,  
       Monopolistic Competition. 

 
 

UNIT – IV 
 
17.  Define National Income. Explain the different methods of measuring national income. 
(OR ) 
18.  Write short notes on: 
        a) Phases of Business Cycles 
        b) Strategies and policies to overcome business cycles. 
 

UNIT – V 
19.  Explain the impact of globalisation on the Indian economy 
. 
(OR ) 
 
20. Write notes on: 
       a) Balance of Trade and Balance of Payments 
       b) Foreign Exchange Markets and factors influencing exchange rates. 
 
 
 
 
 
 
 
 
 
 
 
 
 

 



 

 

                                      
 

 

I B. Com HONOURS IN BANKING FINANCIAL SERVICES & INSURANCE 

 SEMESTER –I: COMMERCE PAPER – III 

                                                  Banking Theory and Practices 

Name of the Programme  :B.Com 
 
Name of the Specific Programme : BFSI (Honors) 
 (Group) 
Semester    : I 
 
Name of the Course (Paper)  :  Banking theory and practices 
 
Course Outcomes   : At the end of the course students able to 
 

 

 

Total No.of Hours per week:4 Total Credits: 4 

 

 

Course Objectives: 

 To Provide an understanding of the 

Indian banking system. 

  To provide awareness of the day-to-day Banking operations. 

 

Course Outcomes: 

      After completion of the course, the student will able to: 

 Explain the different types of commercial banks. 

 Discuss the consequences of Liberalizationon Banking Sector. 

 Distinguish between Unit Banking and Branch Banking 

 Analyse the innovations in Banking Sector. 

 AppraisethegeneralandspecificrelationshipbetweenBankerandCustomer. 

 Explain the different lending processes that are in vogue in a Bank. 

 Evaluate the credit creation process 

 Explain the provisions relating to Non-Performing assets. 

 Discuss the role of banking in the Development of an Economy 

 

 



 

 

Syllabus 

 

Unit 1: Introduction: Indian banking system: History - Classification -Meaning of 

Banks- Characteristics of Banks-Commercial Banks: Meaning–Types-functions of 

commercial banks - Role of banks in the Development of economy- Banking Sector 

Reforms: Liberalization of Banking Sector 

 

Unit 2:Types of Banks: Indigenous Banking - Cooperative Banks, Regional Rural 

Banks, SIDBI, NABARD - EXIM Bank. – Paying banker and collecting banker– 

Innovations in Banking – E banking - Online and Offshore Banking - Internet Banking 

-Anywhere Banking -ATMs – RTGS- NEFT – Mobile Banking– Digital Bank 

 

Unit 3: Banker and Customer: Meaning and Definition of Banker and Customer 

– Types of Customers – General Relationship and Special Relationship between 

Banker and Customer KYC - Norms – Negotiable Instruments: Meaning and 

Features of Promissory note, Bills of Exchange and -Cheques – different types of 

Crossing cheque. 

 

Unit 4: Deposits, Loans and Advances: Process of opening bank accounts - pay in 

slip - Cheque book - Pass book- ATM cum Debit card - Credit Card - No Frill 

Account. Loans and Advances: Introduction - classification of loans -principles of 

good lending - loan procedure followed by banks. 

 

Unit 5: Reserve Bank of India: Functions-Techniques of Credit Control – Credit 

Creation:Meaning&ProcessofCreditCreation.Non-PerformingAssets:Concept- 

Classification of NPAs- Provision for NPAs- Management of NPAs. 

 

Reference: 

Guru Swamy,“Banking Theory and Practice”Tata  McGrawHill 
Krishna,RajuandManjusha,Priya,“BankingTheoryandPractice”PragathiPrakashaneducational 
Publishers. 
E.Gordon&K.Natarajan,“BankingTheoryandPractice”,HimalayaPublishingHouse 
        

Signature of the Internal BOS Members 

1. 

2. 

3. 

4. 

5. 

 

 



 

 

 

 
 

I B. Com HONOURS IN BANKING FINANCIAL SERVICES & INSURANCE 

SEMESTER –I: COMMERCE PAPER – I 

 

BANKING THEORY AND PRACTICE 

 

BLUE PRINT FOR THE MODEL PAPER 

 

 

S. 

NO  
 

 

Type of 

Question  
 

 

To be given in the Question Paper  
 

 

To be answered 
 

No. of 

Question 
 

Marks 

allotted to 

each 

question 
 

Total 

Marks  
 

No. of 

Questions  
 

Marks 

allotted 

to each 

question  
 

Total 

Marks  
 

1 

 

Section - A 

(Short 

Questions) 

10 5 50 5 4 20 

2 Section - B 

(Essay 

Questions) 

10 10 100 5 10 50 

Total Marks 

 

150 Total Marks 70 

 

 

 

 

 

 

 

 

 

 

 

25BFS103T 



 

 

 

 

 
I B. Com HONOURS IN BANKING FINANCIAL SERVICES & INSURANCE 

SEMESTER –I: COMMERCE PAPER – I 
BANKING THEORY AND PRACTICE 

                                                                     Code: 25BFS103T 

 

BLUE PRINT FOR THE QUESTION PAPER SETTING 

 

Chapter Name   
 

Short questions 

5 marks   

Essay questions  10 

marks  
 

UNIT – I 2 2 

UNIT – II 2 2 

UNIT – III 2 2 

UNIT – IV 2 2 

UNIT – V 2 2 

Total No. of Questions  

 

10 10 

 

 

Signature of the Chairman   Signature of the BOS Members  

            

 

 

 

 

 

 

 

 

 

 

 

 

 



 

 

 

I B.Com (Honours) in Banking, Financial Services & Insurance 

Semester – I 

COMMERCE PAPER – III: BANKING THEORY AND PRACTICES 

CODE:25BFS103T 

Time: 2:1/2                                                                                                                              Max. Marks: 70 

SECTION – A 

(Answer any FIVE of the following questions) 

5 × 4 = 20 Marks 

1. Define a Bank? 

2. Write a short note on the classification of banks in India? 

3. Explain the role of banks in the economic development of a country? 

4. What is E-Banking?  

5. Differentiate between Paying Banker and Collecting Banker? 

6. Write a short note on KYC norms? 

7. Define a Promissory Note ? 

8. What are the different types of bank deposits? 

9. Define Non-Performing Assets (NPAs). How are they classified? 

10. Difference between debit ad credit card? 

SECTION – B 

(Answer ONE question from each Unit) 

5 × 10 = 50 Marks 

Unit – I 

Q11. Explain the history of the Indian banking system and discuss the major banking sector reforms 

after liberalization? 

OR 

Q12. What are commercial banks? Explain their  and functions in detail? 



 

 

Unit – II 

Q13. Explain the structure and functions of NABARD ? 

OR 

Q14. Discuss the features of RTGS, NEFT, and Mobile Banking? 

Unit – III 

Q15. Define a Banker and Customer. Explain the  special relationships between them? 

OR 

Q16. What is a Negotiable Instrument? Explain the features of Cheques and the different types of 

cheque crossings? 

Unit – IV 

Q17. Describe the various types of loans and advances given by commercial banks? 

OR 

Q18. Explain the procedure for opening a bank account. What are the documents required as per 

KYC norms? 

Unit – V 

Q19. Explain the functions of the Reserve Bank of India. Discuss the techniques of credit control used 

by RBI? 

OR 

Q20. What do you mean by credit creation? Explain the process of credit creation by commercial 

banks and discuss the management of NPAs? 

 

Signature of the Members:                                                                     Signature of the BOS Chairman:  

 

 

 

 

 

 

 

 



 

 

 

I B.Com HONOURS IN BANKING FINANCIAL SERVICES & INSURANCE 

SEMESTER –I 

Skill enhancement Course  

Accounts Assistant -1 

      Credits: 04       Teaching Hrs/Week : 6 

 

SYLLABUS 

Course Objectives: 

● To introduce and deepen understanding of accounting principles and financial statements. 

● To provide advanced skills in payroll accounting and labour law compliance. 

● To familiarise students with income tax returns, deductions, and tax compliance. 

● To enhance practical applications in financial reporting, analysis, and compliance. 

● To develop professional and employability skills necessary for a career in accounting. 

Unit 1: Introduction to Accounting 

Overview of the Accounts Assistant role and responsibilities -Basic accounting concepts and 

terminologies - Accounting Concepts and Conventions –Accounting Cycle- Double Entry 

Accounting System- Classification of Accounts.  

Unit 2: Payroll Accounting and Labour Laws 

Introduction to labor laws: Payment of Wages Act, Minimum Wages Act.-Payroll accounting: Salary – 

types of salary, deductions and benefits -PF and ESI registrations - Introduction to gratuity and Bonus. 

Unit 3: Income Tax Basics  

Overview of the Income Tax Act and  heads of income—TDS and Advance Tax overview. 

Introduction to tax deductions under Chapter VI-A (Sections 80C to 80U) -New Tax Regime 

Unit 4: Income Tax Return Filing, and Tax Planning 

 Filing of income tax returns (ITR-1, ITR-2, and ITR-3) - Introduction to tax planning strategies - 

PAN registration, refund procedures, and tax audit basics. 

Unit 5: Cash flow statements: Concept of Cash flow statements – objectives - importance 

– classifications- operating activities -investing activities - financing activities- methods - 

direct method & indirect method 



 

 

 

I B. Com HONOURS IN BANKING FINANCIAL SERVICES & INSURANCE 

SEMESTER –I: COMMERCE PAPER - IV 

Subject: Accounts Assistant                                                           

 

BLUE PRINT FOR THE MODEL PAPER 

 

 

 

S. 

NO  
 

 

Type of 

Question  
 

 

To be given in the Question Paper  
 

 

To be answered 
 

No. of 

Questions 
 

Marks 

allotted to 

each 

question 
 

Total 

Marks  
 

No. of 

Questions  
 

Marks 

allotted 

to each 

question  
 

Total 

Marks  
 

1 

 

Section - A 

(Short 

Questions) 

10 5 50 5 4 20 

2 Section - B 

(Essay 

Questions) 

10 10 100 5 10 50 

Total Marks 

 

150 Total Marks 70 

 

 

Signature of the Members       Signature of the BOS Chairman 
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I B. Com HONOURS IN BANKING FINANCIAL SERVICES & INSURANCE 

SEMESTER –I: COMMERCE PAPER – I 

Subject: Accounts    Assistant 

                                                                                                                        25BFS101S 

 

BLUE PRINT FOR THE QUESTION PAPER SETTING 

 

Chapter Name   
 

Short questions 

5 marks   

Essay questions  10 

marks  

 

UNIT – I 2 2 

UNIT – II 2 2 

UNIT – III 2 2 

UNIT – IV 2 2 

UNIT – V 2 2 

Total No. of Questions  

 

10 10 

 

 

Signature of the        Signature of the BOS 

Members             Chairman 

 

 

 

 

 

 

 

 

 

 

 

 



 

 

 

 

 

 
 

I B. Com HONOURS IN BANKING FINANCIAL SERVICES & INSURANCE 

 SEMESTER –I:  

Skill enhancement Course  

ACCOUNTS ASSISTANT 

 

Time :3hrs   Code: 25BFS104S               Max Marks : 70Marks 

_________________________________________________________________________ 

 

 MODEL QUESTION PAPER 

SECTION – A 

Answer any Five of the following Questions     5X4 =20 Marks 

1) Define Accounting 

2)  Payroll  

3) Advance tax 

4) PAN 

5) Cash flow statement 

6) Accounting cycle 

7) Classification of Accounts 

8) TDS 

9) Define Ratio Analysis and explain its importance. 

10) What is meant by Professional Ethics in Finance? 

 
        Answer any One from each unit of the following Questions             5X10= 50 Marks 

 

UNIT – I 

11.Explain the role and responsibilities of an Accounts Assistant and discuss the basic 

accounting concepts and terminologies. 

OR 

12.Prepare a Bank Reconciliation Statement from the following data: 

 Balance as per Cash Book: Rs.25,000 



 

 

 Cheques issued but not presented: Rs 3,000 

 Cheques deposited but not yet credited: Rs 2,500 

 Bank charges not recorded in Cash Book: Rs 500 

 Interest credited by bank: Rs 1,000 

(Show workings and compute the balance as per the Pass Book.) 

UNIT – II 

13. Explain the computation of salary under Payroll Accounting and discuss various 

deductions and employee benefits. 

OR 

14. Write short notes on the following: 

a) Payment of Wages Act 

b) Minimum Wages Act 

c) Gratuity and Bonus Calculations 

UNIT – III 

15.Explain the five heads of income under the Income Tax Act with suitable examples. 

OR 

16.Discuss the deductions available under Chapter VI-A (Sections 80C to 80U) and explain the 

features of Section 115BAC (New Tax Regime). 

UNIT – IV 

17.Explain the procedure for computing total income and filing of Income Tax Returns (ITR-1, ITR-2, 

and ITR-3). 

OR 

18.Write short notes on the following: 

a) PAN registration and refund procedure 

b) Tax Audit 

c) Tax Planning and Avoidance 

UNIT – V 

19.Discuss the techniques of financial statement analysis such as ratio analysis, fund flow, and cash 

flow statements. 

OR 

20.Explain the importance of working capital management and budgeting in business. Also discuss 

the role of ethics in financial reporting. 



 

 

 

DEPARTMENT OF COMMERCE 

Common to All Groups – Semester I 

 
Course Code Title of the Course L S/M P C 

25BCS101S AI Fundamentals    4  4 

Prerequisites                      Basics of Computers 

 

COURSE OBJECTIVES 

1 Understand the history and evolution of Artificial Intelligence and Identify major subfields of AI. 

2 Investigate the role of AI in various industries like healthcare, agriculture, and education. 

3 Examine concepts like bias, fairness, transparency, and accountability in AI systems. 

4 
Explore the integration of AI in scientific research and discuss future directions and evolving 

trends in AI. 

5 Learn how prompt engineering is used in various sectors like education and content creation. 

 

 

COURSE OUTCOMES 
BTL 

Upon successful completion of the course, the student will be able to: 

CO1 Describe the different subfields and their roles in AI applications. Understanding 

CO2 
Summarize the benefits and limitations of AI in diverse domains. 
 

Understanding 

CO3 Operate AI systems in terms of inclusivity, privacy, and robustness. Applying 

CO4 Practice Generative AI and emerging technologies like ChatGPT. Applying 

CO5 Apply prompt engineering concepts to various real-world use cases. Applying 

 
 
 



 

 

SEMESTER –I:  SKILLPAPER  
DEPARTMENT OF COMMERCE 

ARTIFICIAL INTELIGENCE FUNDAMENTALS  

Syllabus 

 

COURSE CONTENT 

UNIT I 

Introduction to Artificial Intelligence: History, Definition, Artificial General 

Intelligence, Challenges in AI. Knowledge Engineering, Machine Learning, Computer 

Vision, Natural Language Processing, Robotics. 

UNIT II Applications of AI: Healthcare, Finance, Retail, Agriculture, Education, Transportation. 

UNIT III 

Bias and Fairness in AI Systems: Ethics in AI, Bias and Fairness in AI Systems, Transparency 

in AI Systems, Accountability, Security, Privacy, Inclusivity, Sustainability, Robustness, 

Reliability. 

UNIT IV 

AI in Research, Generative AI and prompt engineering: AI in Experimentation and 

Multi-disciplinary research, Generative AI introduction, ChatGPT, Hugging Face, 

Gemini, Copilot, Perplexity. 

UNIT V 

Prompt engineering: Prompt engineering Definition and its importance, Role of Prompt 

Engineering in AI/ML Interaction. 

Applications of Prompt Engineering: Education, Business & Commerce,  

Content Creation: AI for Creative Writing, AI for creative design, writing AI scripts for 

video, generating slides and slidesGPT usage. 

 

 

TEXT BOOKS 

1. 
AI for Everyone: A Beginner's Handbook for Artificial Intelligence (AI) by Saptarsi Goswami, Amit 

Kumar Das, Amlan Chakrabarti 

2. Prompt Engineering for Beginners: by Kapila Arora, Geetu Garg, Gaurav Arora. 

REFERENCE BOOKS 



 

 

1. Let’s Learn Artificial Intelligence: Base Module, Niti Ayog, Atal Innovation Mission. 

2. 
Prompt Engineering for Generative AI: Future-proof inputs for Reliable AI-outputs by James 

Phoenix & Mike Taylor. 

3. 
Generative AI 360°: Practical Guide to ChatGPT, Midjourney & AI Tools to Boost Productivity 

&Creativity, For Professionals, Marketers & Entrepreneurs by Hitesh Motwani,Zebra Learn, 2025. 

WEB RESOURCES 

1. 

Learn Generative AI Prompt Engineering for everyone. https://www.coursera.org/learn/generative-ai-

prompt-engineering-for-everyone?action=enroll 

 

2. 

Generative AI Tutorial:https://www.w3schools.com/gen_ai/ 

 

3. 

Free Artificial Intelligence (AI) Tutorial - Hands-On Prompt Engineering for AI Beginners & Business User | 

Udemy, https://www.udemy.com/course/prompt-engineering-for-ai-beginners-business-users 

 

 

 

CO-POMapping:  

 

  PO1 PO2 PO3 PO4 PO5 PO6 PO7 PO8 PO9 PO10 PSO1 PSO2 PSO3 PSO4 

CO1 1 1 1 2 2 1 0 0 1 0 1 0 1 0 

CO2 1 1 1 2 2 1 0 0 1 0 1 0 1 0 

CO3 1 1 1 3 2 2 2 1 2 2 3 1 3 0 

CO4 2 2 1 3 3 2 2 1 3 2 3 1 3 1 

CO5 2 2 1 3 2 2 2 1 2 2 3 1 3 1 

 

https://www.coursera.org/learn/generative-ai-prompt-engineering-for-everyone?action=enroll
https://www.coursera.org/learn/generative-ai-prompt-engineering-for-everyone?action=enroll
https://www.w3schools.com/gen_ai/
https://www.udemy.com/course/prompt-engineering-for-ai-beginners-business-users


 

 

 

DEPARTMENT OF COMMERCE 

SEMESTER –I:  SKILLPAPER  
ARTIFICIAL INTELIGENCE FUNDAMENTALS  

Model Blueprint for the question paper setter 

 

Sl. No. UNIT- Essay 10M Weightage 

1 I 2 20% 

2 II 2 20% 

3 III 2 20% 

4 IV 2 20% 

5 V 2 20% 

  100 100% 

 

 

 

 

 

 



 

 

 

AI Fundamentals- Common to all Groups 

Semester-I 
Recommended Format of Question Paper for all Courses 

Time: 3 Hours                                                                                        Max. Marks: 70 
_________________________________________________________________ 

Section-A 
    Answer any FIVE of the following questions.    5X4=20 

1. From Contents of Unit-I 

2. From Contents of Unit-I 

3. From Contents of Unit -II 

4. From Contents of Unit -II 

5. From Contents of Unit -III 

6. From Contents of Unit -III 

7. From Contents of Unit -IV 

8. From Contents of Unit -IV 

9. From Contents of Unit -V 

10. From Contents of Unit -V 

Section-B 

Answer FIVE questions.        5X10=50 
A) From Contents of Unit-I 
OR 
B) From Contents of Unit-I 
A) From Contents of Unit-II 
 OR 
B) From Contents of Unit -II 
A) From Contents of Unit -III 
OR 
B) From Contents of Unit -III 
A) From Contents of Unit -IV 
OR 
B) From Contents of Unit -IV 
A) From Contents of Unit -V 
OR 
B) From Contents of Unit –V 



 

 

 

AI FUNDAMENTALS 
MODEL QUESTION PAPER (W.E.F 2025-2026) Common to All Groups 

 

Time: 3Hrs.                                                                                     Marks:70 

 

 

 
 

 

 

 

 

 

Q. No Question Marks BL CO PO PI 

SECTION – A 

Answer any Five of the Following 5 X 4 = 20M  

1 Explain about Machine Learning. 4M 2 1   

2 Discuss about Robotics. 4M     2 1   

3 Illustrate the AI applications in Finance sector 4M 2 2   

4 Explain how AI can be applied in transportation. 4M 2 2   

5 What is ethics in AI? 4M 1 3   

6 Discuss about Accountability and Security in AI 
Systems. 

4M 2 3   

7 How is Copilot used? 4M 2 4   

8 What is Hugging face? 4M 1 4   

9 Define prompt engineering. 4M 1 5   

10 What are the applications of Prompt engineering in 
Education? 

4M 1 5   



 

 

 
Common to All Groups – Semester I 

CourseCode TitleoftheCourse L T P C 

25BCS101L AI FUNDAMENTALS   2 0 

Prerequisites Basic Computer Knowledge 

 

Practice Session 

1.Create a mind map of AI subfields: NLP, CV, ML, Robotics, Knowledge Engineering using 

Canva/Napkin AI/ Similar Open AI tool  

2. Text Analysis with Open-Source NLP Tools: Tool: Voyant Tools (text analysis web app)  

● Input sample texts (e.g., news articles, speeches).  

● Explore word frequency, keywords, sentiment.  

● Understand how NLP extracts meaning from text.  

3. Train a basic image classifier using webcam images. Observe how the model "learns." Using 

Google Teachable Machine  

● Train two image categories (e.g., “Smiling” vs. “Not Smiling”) using their own webcam images.  

● Observe how the model learns to classify.  

● Now try feeding images of people with different skin tones, facial features, etc.  

● Observe misclassifications or differences in confidence.  

4. Simulate an AI chatbot helping a farmer or a student. You may use any GenAI tool of your 

choice. You may use the prompt below and also try your own.  

Prompt:  

“Act as an agriculture assistant. A farmer wants to know the best crop based on soil and season. 

Ask questions and suggest crops.”  



 

 

5. Test Generative AI- Generate a poem or image from prompt “A futuristic green city.” using 

ChatGPT, Hugging Face (e.g., image or text generation)  

6. Observe how generative AI models may show biased results when prompted with neutral 

profession descriptions. (Bing Image Creator / DALL·E on ChatGPT/ChatGPT). Generate images 

using the following neutral prompts:  

● “A doctor treating a patient”  

● “A teacher in a classroom”  

● “A CEO giving a speech”  

● “A software engineer working from home” Observe and discuss:  

● What gender/race/age are most commonly shown? ● Are the results stereotypical or 

diverse?  

7. Check how language models may express bias depending on names, ethnicity, or location.  

Use Chat GPT or Gemini  

Prompts:  

Prompt A:  

“A person named Raj is applying for a bank loan. Will he be approved?”  

Prompt B: 

“A person named John is applying for a bank loan. Will he be approved?”  

Change names, genders, and nationalities.  

Observe the following and report your findings:  

● Are the responses different?  

● Is one version more positive or negative?  

● Does the model express bias or hesitate?  

● Should AI make such predictions?  

● How do developers prevent this?  

 



 

 

8. Exploring Text Generation and Summarization with Google AI Studio  

Generate Creative Content  

“Write a short story (150 words) about a robot who wants to become a chef.”  

● Submit and read the AI-generated story.  

● Discuss how detailed and creative the output is.  

Summarize a Paragraph  

Prompt:  

Summarize the following paragraph in 3 sentences:  

“Artificial Intelligence is a branch of computer science that aims to create intelligent machines 

that can mimic human thinking. It includes various subfields like machine learning, natural 

language processing, and robotics. AI is widely used in industries such as healthcare, finance, 

and transportation to improve efficiency and decision-making.”  

● Submit and review the summary.  

● Evaluate how well AI extracts key points.  

Refine Your Prompt  

Try changing the summary prompt to:  

“Summarize the paragraph above in simple language for 10-year-olds.”  

● Compare this output to the previous one. 

● Note how prompt wording changes results.  

 

9. AI for Creative Writing  

Prompt:  

“Write a short motivational story for 10-year-old students in under 150 words.”  

 

10. Generate Slides: Tool: SlidesGPT/ Another Free AI tool  



 

 

Prompt:  

“Create a 5-slide presentation on ‘AI in Smart Farming’.”  

 

11. YouTube Thumbnails / Branding: Tool: Canva + Magic Media AI  

Design a thumbnail using Canva’s AI tools with a prompt like:  

“Design a YouTube thumbnail for a video titled ‘Top 5 AI Tools for Students’.” 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 



 

 

 

 

                                  Department of Commerce 

FOR UG B.COM BFSI HONOURS 
ACADEMIC YEAR 2025-2026 

 

Sl. No Course Codes Course Internal External Max. Marks hrs  Credits 

1 25BFS204T Taxation 30 70 100 5 4 

2 25BFS205T Branch Banking Operation 30 70 100 4 4 

3 25BFS206T Social Media Marketing and 

Advertising 

30 70 100 4 4 

4 25BFS202S GST 30 70 100 6 4 

5 25BFS202S 

25BFS202L 

Artificial Intelligence 30 70 100 6 4 

 

 

 

 

 

 

 

 

 

 

 

 



 

 

                          

                                                    Department of Commerce 

FOR UG B.COM BFSI HONOURS 
ACADEMIC YEAR 2025-2026 

                                        Semester II COMMERCE PAPER - IV 

                                  Major– Course Taxation 

 

Total No.of Hours per week: 5 Total Credits:4 

 

 

Course Objectives: 

 To provide an understanding of the provisions of Direct-tax laws 

 To provide an understanding of the provisions of Indirect-tax laws 

 
Course Outcomes: After completion of the course the student will be able to 

1. Explain the different types of direct taxes. 

2. Discuss the Constitutional provisions relating to taxation(Both Direct and Indirect) in 
India. 

3. Assess the residential Status of Individuals and Companies. 

4. Analyze the individual's total Income to determine tax liability. 

5. Determine strategies for reducing indirect tax. 

6. Explain the concepts of Direct tax and Indirect Tax 

 

 

 

 



 

 

SYLLABUS 

UNIT:1 Introduction to Direct Taxes 

Meaning - Historical perspective and evolution of direct taxation - Constitutional provisions 

related to Direct taxation in India-Distribution of tax in powers between the central and state 

governments. 

UNIT:2 Income Tax Laws and Regulations 

Income Tax Act, 1961: Concepts: Person, Assessee, Previous Year, Assessment Year, Income - 

Determination of residential status for individuals and companies - Scope of total income – 

Heads of Income: Income from salary, house property, business or profession, capital gains, and 

other sources 

UNIT 3:Tax Deductions, Exemptions and Rebates 

Deductions and Exemptions: Deductions under Section80C,80D, 80G,Exemptions for 

agricultural income, dividends - Tax Rebates and Relief - Rebates under Section 87A - Relief 

under Double Taxation Avoidance Agreements (DTAA)- Section115BAC of Income tax Act 

Tax under new regime Regime. 

UNIT4:IndirectTaxes 

Evolution of indirect taxation in India-Definition and Types of Indirect Taxes-Basic concepts 

in Indirect taxation – Role and Importance of Indirect Taxes in the development of an 

Economy - An Overview of GST – Objectives of GST. 

UNIT 5: Customs and Indirect Tax Planning: International Trade: An Over view of Customs 

Act 1962 - Customs duties on exports and imports - Strategies for minimizing indirect taxes. 

             References 

1. Singhania,V.K.& Monica Singhania–Students’ Guide to IncomeTax. 

2. Mehrotra& Goyal – Direct Taxes: Lawand Practice. 

3. Datey,V.S.–Indirect Taxes: Lawand Practice. 

4. BareActs: Income TaxAct,1961;Customs Act,1962 ;GSTAct. 
 

 

 

 



 

 

 
 

I B. Com HONOURS IN BANKING FINANCIAL SERVICES & INSURANCE 

SEMESTER –II: COMMERCE PAPER – IV 

TAXATION 

                                                                Code: 25BFS204T 

 

BLUE PRINT FOR THE MODEL PAPER 

 

 

S. 

NO  
 

 

Type of 

Question  
 

 

To be given in the Question Paper  
 

 

To be answered 
 

No. of 

Question 
 

Marks 

allotted to 

each 

question 
 

Total 

Marks  
 

No. of 

Questions  
 

Marks 

allotted 

to each 

question  
 

Total 

Marks  
 

1 

 

Section - A 

(Short 

Questions) 

10 5 50 5 4 20 

2 Section - B 

(Essay 

Questions) 

10 10 100 5 10 50 

Total Marks 

 

150 Total Marks 70 

 

 

 

 

 

 

 



 

 

 
I B. Com HONOURS IN BANKING FINANCIAL SERVICES & INSURANCE 

SEMESTER –II: COMMERCE PAPER – IV 
TAXATION 

                                                                Code: 25BFS204T 

 

BLUE PRINT FOR THE QUESTION PAPER SETTING 

 

Chapter Name   
 

Short questions 

5 marks   

Essay questions  10 

marks  
 

UNIT – I 2 2 

UNIT – II 2 2 

UNIT – III 2 2 

UNIT – IV 2 2 

UNIT – V 2 2 

Total No. of Questions  

 

10 10 

 

 

Signature of the Chairman   Signature of the BOS Members   

           

 

 

 

 

 

 

 

 

 

 

 

 

 



 

 

 
I B. Com HONOURS IN BANKING FINANCIAL SERVICES & INSURANCE 

SEMESTER –II: COMMERCE PAPER – IV 
TAXATION MODEL QUESTION PAPER 

                                                                Code: 25BFS204T                     

TAXATION 

 

Time :3hrs                                                Code: 25BFS204T                             Max Marks : 70 

 

MODEL QUESTION PAPER 

 

PART - A 

I. Answer any Five from the following Questions.                                               5*4 = 20M 

1. Define Direct Taxes. 

2. Explain the evolution of direct taxation in India. 

3. What are the constitutional provisions relating to direct taxes in India? 

4. Distinguish between Previous Year and Assessment Year. 

5. Explain the term “Residential Status” for an individual. 

6. What are the five heads of income under the Income Tax Act, 1961? 

7. Write short notes on deductions under Section 80C. 

8. What is meant by agricultural income? Is it taxable? 

9. What are the objectives of Goods and Services Tax (GST)? 

10. Explain the importance of indirect tax planning 

 

 



 

 

 

PART - B 

II. Answer one question from each unit of the following Questions       (5 x 10 = 50M) 

Unit - I 

11. Explain the historical background and evolution of direct taxation in India. 

Or  

12. Discuss the constitutional provisions related to direct taxation and the distribution of taxing 

powers between the Central and State Governments. 

Unit - II 

 

13. Explain the key concepts under the Income Tax Act, 1961 — Person, Assessee, Income, 

Previous Year, and Assessment Year. 

                                                                     OR 

14. Describe the scope of total income and discuss in detail the five heads of income 

Unit - III 

 

15. Explain the various deductions available under Sections 80C, 80D, and 80G of the Income 

Tax Act, 1961. 

OR 

16. Write short notes on: 

a) Tax rebate under Section 87A 

b) Relief under DTAA 

c) Taxation under the new regime (Section 115BAC). 

Unit – IV 

17. Trace the evolution and importance of indirect taxation in India. 

OR 

18. Define GST. Explain its objectives and significance in the Indian economy 

 

 



 

 

Unit – V 

19. Explain the main provisions of the Customs Act, 1962 relating to import and export duties. 

 

OR 

 20. Discuss various strategies for minimizing indirect taxes in international trade. 

 
 
 
 
Signature of the Members                                          Signature of the BOS Chairman 

 

 



 

 
 

 

 

 
I B. Com HONOURS IN BANKING FINANCIAL SERVICES & INSURANCE 

SEMESTER –II: COMMERCE PAPER – IV 

 
BRANCH BANKING OPERATION 

Code: 25BFS205T 

                                               

 

Total No.of Hours per week:4 Total Credits:4 

 

Course Objectives: 

 To provide an overview of bank branch operations in India. 

 To provide understanding of the legal framework for branch banking in India. 

 

Course Outcomes: After completing the course the student will be able to 

 Appraise the basic functions of Branch Banking 

 Distinguish between unit banking and branch banking. 

 Explain the account opening procedure at a bank branch. 

 Discuss the different clauses issued by SEBI for branch banking. 

 Describe the retail banking product Development process. 

 Evaluate the integration of technology in branch banking. 

 

 

 

 

 

 

 

 

 

 

 



 

 
 

 

SYLLABUS 

UNIT -1: Branch Banking: Concept and Basic Functions of Branch Banking- 

AdvantagesandDisadvantages-UnitBankingVs.BranchBanking-TypesofBranch Banking - 

Roles and responsibilities of a branch manager. 

 

UNIT-2:Branch banking Services: Account Opening Procedure – PLSA ccount - Current 

Account-Term Deposits - Call Deposits - Special Deposit Schemes of various banks- Operation in 

Accounts - Transfer Delivery & Clearing—Lockers’ Operations – Inward & Outward Bills for 

collection. 

 

UNIT-3:Branchbanking Management: Legal Framework for Branch banking in India- Branch 

location policies and decisions - Branch Licensing - Scrutiny & Payment of Cheques - TQM in 

branch banking, regulations by SEBI for branch banking . 

 

UNIT-4: Retail Bank Products: Products development process - Description of Liability 

products -Description of Asset Products- Credit cards - Debit Cards: Eligibility, Purpose, 

Amounts, Margin, Security, Process of using the cards, Billing Cycle, Credit Points. 

 

Unit -5: Selling of Retail Products: Marketing /Selling of retail products, Tie –up with 

Institutions for Delivery Channels – Branch, Extension counters, Branch Banking 

Technologies: ATM-POS-Internet Banking -M- Banking. 

 

References: 

 

1. Taxmann's Guide to Bank Branch Management | Enhancing Efficiency and 

Effectiveness of Bank Branches–Practical and comprehensive guide providing 

strategic insights and up-to-date information, Tara Prasad Misra· 2023. 

2. Basics of Banking Operations Hardcover–2January2024 by Ragini Agrawal. 

 

 

 

 

 

 

https://www.google.co.in/search?sa=X&sca_esv=c8ddd2c726ef673e&sca_upv=1&biw=1280&bih=551&tbm=bks&tbm=bks&q=inauthor%3A%22Tara%2BPrasad%2BMisra%2B%22&ved=2ahUKEwji9pKjhr6IAxURcvUHHfniCKMQ9Ah6BAgHEAU
https://www.amazon.in/s/ref%3Ddp_byline_sr_book_1?ie=UTF8&field-author=Ragini%2BAgrawal&search-alias=stripbooks


 

 
 

 
 

I B. Com HONOURS IN BANKING FINANCIAL SERVICES & INSURANCE 

SEMESTER –II: COMMERCE PAPER – V 

BRANCH BANKING OPERATIONS 

Code: 25BFS205T 

 

BLUE PRINT FOR THE MODEL PAPER 

 

 

S. 

NO  
 

 

Type of 

Question  
 

 

To be given in the Question Paper  
 

 

To be answered 
 

No. of 

Question 
 

Marks 

allotted to 

each 

question 
 

Total 

Marks  
 

No. of 

Questions  
 

Marks 

allotted 

to each 

question  
 

Total 

Marks  
 

1 

 

Section - A 

(Short 

Questions) 

10 5 50 5 4 20 

2 Section - B 

(Essay 

Questions) 

10 10 100 5 10 50 

Total Marks 

 

150 Total Marks 70 

 

 

 

 

 

 

 

 

 



 

 
 

 
I B. Com HONOURS IN BANKING FINANCIAL SERVICES & INSURANCE 

SEMESTER –II: COMMERCE PAPER – V 
BRANCH BANKING OPERATIONS 

Code: 25BFS205T 

 

BLUE PRINT FOR THE QUESTION PAPER SETTING 

 

Chapter Name   
 

Short questions 

5 marks   

Essay questions  10 

marks  
 

UNIT – I 2 2 

UNIT – II 2 2 

UNIT – III 2 2 

UNIT – IV 2 2 

UNIT – V 2 2 

Total No. of Questions  

 

10 10 

 

 

Signature of the Chairman   Signature of the BOS Members  

            

 

 

 

 

 

 

 

 

 

 



 

 
 

I B. Com HONOURS IN BANKING FINANCIAL SERVICES & INSURANCE 

SEMESTER –II: COMMERCE PAPER – V 
BRANCH BANKING OPERATIONS 

Code: 25BFS205T 

QUESTION PAPER MODEL  

 

SECTION – A 

Answer any FIVE of the following questions.(5 × 4 = 20 Marks) 

 

1.Define branch banking. 

2.List any four advantages of branch banking. 

3.Distinguish between current account and savings account. 

4.What are term deposits? Mention their types. 

5.Write a short note on branch licensing policy in India. 

       6.Explain the importance of Total Quality Management (TQM) in branch banking. 

       7.What are liability products in retail banking? Give examples. 

       8.Write short notes on credit cards and their uses. 

      9.Mention the various delivery channels used in modern branch banking. 

    10.What are the roles and responsibilities of a branch manager? 

SECTION – B 

Answer ONE question from each Unit.                                          (5 × 10 = 50 Marks) 

 

 

UNIT – I 

Q11. Explain the advantages, and disadvantages of branch banking. 

OR 

Q12.Difference Between Unit Banking and Branch Banking. 



 

 
 

 

UNIT – II 

Q13. Describe the procedure for opening different types of bank accounts. Explain the 

features of PLS Account, Current Account, and Term Deposits. 

OR 

Q14. Explain the various services offered under branch banking. 

 

UNIT – III 

Q15. Discuss the legal framework governing branch banking in India.OR 

Q16. Explain the process of scrutinyand payment of cheques. What is the role of SEBI in 

regulating branch banking? 

 

UNIT – IV 

Q17. Describe the product development process in retail banking and explain various liability 

and asset products. 

OR 

Q18. Write detailed notes on credit and debit cycle, and credit points. 

 

UNIT – V 

Q19. Explain the marketing and selling strategies used by banks for retail products? 

OR 

Q20. Discuss the technological advancements in branch banking, focusing on ATM, POS, 

Internet Banking, and MobileBanking. 
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I B. Com HONOURS IN BANKING FINANCIAL SERVICES & INSURANCE 

SEMESTER –II: COMMERCE PAPER – VI 
SOCIAL MEDIA MARKETING 

Code: 25BFS206T 

SYLLABUS 

 

Theory Credits: 4                                                                            Teaching hours: 4hrs/week                                    

COURSE OBJECTIVE: 

Introduce current and core practices of Digital and Social Media Marketing that will allow learners 
to analyze ,plan, execute and evaluate a digital marketing strategy. 

Learning outcomes: 

Understand the Social Media space and tools 

• Analyzetheeffectivenessofyourcompany’sandcompetitors’socialmediaprograms. 

• Designsocialmediaprogramsthatdirectlysupportbusinessandmarketinggoals. 

• Channels and programs. Implement a process for planning 

• Social media marketing activities. 

 To develop an awareness of the major types of 

advertising and role of Ad agencies. 

 To understand the basics of Advertising and media planning. 

 To know the importance of advertising budgeting, 

advertising agencies and evaluating advertising campaigns. 

 
 

 

 

 

 

 

 



 

 
 

SOCIAL MEDIA MARKETTING 

UNIT I: Introductiontodigitalandsocialmediamarketing-meaning-definition-types of social media 

websites-mobile apps-email- social media-various social media websites; Blogging-types, 

platforms. 

 

UNIT II: Social Media Strategy-Goals , Planning, Strategies, Monitoring Analysis Tips of Social 

Media Marketing- Customization Social Media Optimization Social Media Promotion-paid 

advertising–other methods-Social Media ROI. 

UNIT  III: Social Media for Marketing-Face book ,LinkedIn, Twitter, YouTube .Establishing 

Relationship with customers Social Media. 

 

UNIT IV: Advertising-Meaning, Importance and objectives of Advertising .History, Classification and 

Functions. Role of Advertising in Promotional Mix. 

 

UNIT V: Types of Advertising, Integrated Marketing Communication. Digital  Advertising-Meaning, 

Advantages,  Limitations, Types of Digital Advertising. 

TEXTBOOKS: 

1. Digital Marketing: Seema Gupta-Mc grawhill 

2. Social Media Mark eting:TracyL. Tuten(2021). 

3. Social Media Marketing: A Strategic Approach .Debra Zahay,MaryLou Roberts 

4. Chat GPT & Social Media Marketing. RyanTurner. 
 

 

 

 

 

 

 

 

 

 

 

 



 

 
 

 
I B. Com HONOURS IN BANKING FINANCIAL SERVICES & INSURANCE 

SEMESTER –II: COMMERCE PAPER – VI 
SOCIAL MEDIA MARKETING 

Code: 25BFS206T 

 

BLUE PRINT FOR THE MODEL PAPER 

 

 

S. 

NO  
 

 

Type of 

Question  
 

 

To be given in the Question Paper  
 

 

To be answered 
 

No. of 

Questions 
 

Marks 

allotted to 

each 

question 
 

Total 

Marks  
 

No. of 

Questions  
 

Marks 

allotted 

to each 

question  
 

Total 

Marks  
 

1 

 

Section - A 

(Short 

Questions) 

10 5 50 5 4 20 

2 Section - B 

(Essay 

Questions) 

10 10 100 5 10 50 

Total Marks 

 

150 Total Marks 70 

 

 

 

 

 

 

 

 

 



 

 
 

 
I B. Com HONOURS IN BANKING FINANCIAL SERVICES & INSURANCE 

SEMESTER –II: COMMERCE PAPER – VI 
SOCIAL MEDIA MARKETING 

Code: 25BFS206T 

BLUE PRINT FOR THE QUESTION PAPER SETTING 

 

Chapter Name   
 

Short questions 

5 marks   

Essay questions  10 

marks  

 

UNIT – I 2 2 

UNIT – II 2 2 

UNIT – III 2 2 

UNIT – IV 2 2 

UNIT – V 2 2 

Total No. of Questions  

 

10 10 
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I B. Com HONOURS IN BANKING FINANCIAL SERVICES & INSURANCE 

SEMESTER –II: COMMERCE PAPER – VI 
SOCIAL MEDIA MARKETING 

Code: 25BFS206T 

MODEL QUESTION PAPER 

SECTION –A 

Answer Any Five From The Following                         ( 5*4 = 20marks) 

1.Define Digital Marketing and explain its importance. 

2.What are the different types of social media websites? 

3.Write a short note on Blogging platforms. 

4.What is Social Media Optimization (SMO)? 

5.Explain the importance of setting goals in social media  strategy. 

6.What are the advantages of using Facebook for marketing? 

7..Write short notes on the role of advertising in the promotional mix. 

8.Mention the types of digital advertising. 

9.What is Integrated Marketing Communication (IMC)? 

10.Explain any four functions of advertising. 

SECTION – B 

Answer one question from each Unit    5 × 10 = 50 Marks 

 

UNIT – I 

Q11. Define Social Media Marketing. Explain the different types of social media websites 

and their uses in marketing. 

 

OR 



 

 
 

Q12. What is Blogging? Discuss various types of blogs and blogging platforms with 

examples. 

UNIT – II 

Q13. Describe the steps involved in developing a social media marketing strategy. 

OR 

Q14. Explain the concept of Social Media Promotion. Discuss the role of paid advertising and 

other promotional methods in social media. 

UNIT – III 

Q15. Explain how businesses can use Facebook, LinkedIn, Twitter, and YouTube for 

marketing purposes. 

OR 

Q16. Discuss how organizations can establish and maintain customer relationships through 

social media. 

UNIT – IV 

Q17. Define Advertising. Explain its meaning, importance, and objectives in business. 

OR 

Q18. Write a note on the classification and functions of advertising. Discuss its role in the 

promotional mix. 

UNIT – V 

Q19. What is Digital Advertising? Explain its meaning, advantages, limitations, and types. 

OR 

Q20. Discuss the concept of Integrated Marketing Communication (IMC) and its significance 

in modern advertising. 
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I B. Com HONOURS IN BANKING FINANCIAL SERVICES & INSURANCE 

SEMESTER  –II: SKILLPAPER – II 
GST 

Code: 25BFS202S 

SEC–GST Assistant 

Total No. of  Hours per week: 4 + 2 Non-Credit Tutorial Hours     Total  Credits:4 e 

Objectives: 

 To Give insights into the Goods and Services Tax(GST),its structure, and 
implementation.

 To provide knowledge of taxable events, compliance, and input tax credits. Legal and 

  Regulatory Framework:

 Toprovideawarenessofthekeylegalandregulatoryframeworksgoverningfinancial 
services

 Togaininsightsintopenalties,offenses,andinspectionproceduresunderGST.
 

Course Outcomes: Upon Successful completion of this course, students will be able to: 

1. Explain the Structure of GST 
2. Discuss the differences between IGST,CGST,SGST,and UTGST,. 
3. Identify Taxable Events: 
4. Analyze various GST tax able events, including supply and transactions between 

distinct persons. 
5. Manage Tax Record sand File Returns 
6. Prepare and maintain tax records 
7. File GST returns using current digital tools. 
8. Accuratelycalculateandapplytheinputtaxcreditinfinancialtransactions. 

 

 

 

 

 

 



 

 
 

SYLLABUS 

UNIT-I:Introduction to GST 

 

Overview of GST-Structure of GST (CGST, SGST, IGST, and UTGST)-Objectives and 

Functions of GST-Significance of GST in the Indian economy-Taxable Event: Supply of 

Goods and Services - GST administration in India. 

 

UNIT-II: Time, Value, and Place of Supply 

 

Key concepts of Time, Value, and Place of Supply under GST-Rules for determining the 

time of supply-Valuation of goods and services for GST-Importance of the place of supply 

and its impact on IGST, CGST, and SGST applicability. 

 

UNIT-III: Input Tax Credit(ITC) 

Concept of Input Tax Credit - Eligibility for claiming ITC - Blocked credits and 

conditionsunderwhichITCisunavailable-Processofcreditreversal-Maintenance of input tax 

records - Calculation of GST liability using ITC. 

 

UNIT-IV: Filing GST Returns: 

 

GST compliance – Regular returns filing (GSTR 1, GSTR 3B, GSTR 9, etc.) - Due 

datesforfilingreturns.Amendment,Revision,-CancellationofReturns-E-WayBill – Concept 

and preparation - TDS and TCS provisions under GST. 

 

UNIT-V:Offenses,Penalties,andAppeals 

 

Types of offenses under GST law - Penalties for various GST-related offenses - Appeals and 

revisions under GST - Provisions related to inspection, search, and seizure - Overview of the 

dispute resolution mechanism under GST. 

 

Suggested References: 

 "Goods and services Tax(GST)in India"by K.Vaitheeswaran. 
 GSTN Portal for e-filing and GST resources: https://www.gst.gov.in/. 
 NationalInstituteofFinancialManagement(NIFM)courses:https://www.nifm.ac

.in/. 
 
 

 

https://www.gst.gov.in/
https://www.nifm.ac.in/
https://www.nifm.ac.in/


 

 
 

 
I B. Com HONOURS IN BANKING FINANCIAL SERVICES & INSURANCE 

SEMESTER –II: SKILL PAPER – II 
GST 

Code: 25BFS202S 

 

BLUE PRINT FOR THE MODEL PAPER 

 

 

S. 

NO  
 

 

Type of 

Question  
 

 

To be given in the Question Paper  
 

 

To be answered 
 

No. of 

Questions 
 

Marks 

allotted to 

each 

question 
 

Total 

Marks  
 

No. of 

Questions  
 

Marks 

allotted 

to each 

question  
 

Total 

Marks  
 

1 

 

Section - A 

(Short 

Questions) 

10 5 50 5 4 20 

2 Section - B 

(Essay 

Questions) 

10 10 100 5 10 50 

Total Marks 

 

150 Total Marks 70 

 

 

 

 

 

 

 

 



 

 
 

 
I B. Com HONOURS IN BANKING FINANCIAL SERVICES & INSURANCE 

SEMESTER –II: SKILL PAPER – III 

GST 

Code: 25BFS202S 

SEC–GST Assistant 

BLUE PRINT FOR THE QUESTION PAPER SETTING 

 

Chapter Name   
 

Short questions 

5 marks   

Essay questions  10 

marks  

 

UNIT – I 2 2 

UNIT – II 2 2 

UNIT – III 2 2 

UNIT – IV 2 2 

UNIT – V 2 2 

Total No. of Questions  

 

10 10 
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I B. Com HONOURS IN BANKING FINANCIAL SERVICES & INSURANCE 

SEMESTER –II: SKILL PAPER – II 

SEC - GST 

 

QUESTION PAPER MODEL 

Time :3hrs                             Code: 25BFS202S                                  Max Marks : 70 

 

PART - A 

I. Answer any Five from the following Questions.                                         5*4 = 20M 

1. Define Goods and Services Tax (GST). What are its main objectives? 

2. Distinguish between CGST, SGST, IGST, and UTGST. 

3. Explain the term “Supply” under GST with examples. 

4. What is meant by “Time of Supply”? How is it determined? 

5. State the importance of “Place of Supply” under GST. 

6. What is Input Tax Credit (ITC)? Explain its advantages. 

7. Write short notes on the E-Way Bill system under GST. 

8. Mention the due dates for filing GSTR-1, GSTR-3B, and GSTR-9. 

9. List any four common offenses under GST law. 

10. Explain briefly the appeal process under GST. 

PART - B 

II. Answer one question from each unit of the following Questions (internal choice).    5 x 10 

= 50 M 

Unit - I 

11. Explain the structure of GST in India. Discuss its significance in the Indian economy. 

Or 

12. Discuss the objectives and functions of GST. How has GST simplified the Indian tax 

system? 

 

Unit - II 

 



 

 
 

13. Explain the concepts of Time, Value, and Place of Supply under GST with suitable 

examples 

OR 

14. Describe the rules for determining the time and place of supply and explain how they 

affect IGST, CGST, and SGST applicability. 

 

Unit - III 

 

15. Define Input Tax Credit (ITC). Discuss the eligibility, blocked credits, and process of 

credit reversal under GST 

OR 

16.Explain the calculation of GST liability using ITC with a suitable example. 

 

Unit – IV 

17. Explain the procedure for filing GST returns and discuss the types of returns and their due 

dates. 

OR 

18. What is an E-Way Bill? Explain its concept, preparation, and significance under GST. 

 

Unit – V 

19. Describe the various offenses and penalties prescribed under the GST law. 

 

OR 

20. Explain the appeal and revision process under GST. Discuss the provisions relating to 

inspection, search, and seizure 

 
 
 
 
 

 

 

 

 

 

 

 



 

 
 

 

Applicable To Commerce and Management– Semester II 

 
 

COURSE OBJECTIVES 

1 
Provide a foundation in the AI ecosystem, including hardware, cloud, and edge platforms 
relevant to commerce and management. 

2 
Familiarize students with different types of datasets and public repositories used in AI 
research. 

3 
Develop skills in building AI data pipelines through collection, annotation, cleaning, and 
preprocessing. 

4 
Understand how AI enhances retail and e-commerce and explore personalization, 
recommendation systems, and customer engagement. 

5 
Apply AI to streamline business processes and decision-making and explore AI in finance, HR, 
and supply chain management. 

 

 

COURSE OUTCOMES 
BTL 

Upon successful completion of the course, the student will be able to: 

CO1 
Explain the AI ecosystem (hardware, cloud, and edge devices) and its 
relevance to commerce and management. 

Understanding 

CO2 
Differentiate between structured and unstructured data, and utilize 
public datasets for business-oriented AI applications. 

Understanding 

CO3 
Implement a conceptual AI data pipeline for solving real-world 
problems in commerce and management. 

Applying 

CO4 
Understand and apply AI technologies to improve customer 
engagement and personalization in commerce. 

Understanding 

CO5 
Use AI tools to streamline business operations, enhance decision-
making, and detect patterns in data. 

Applying 

 

 

 

 

 

Course Code Title of the Course L S/M P C 

25BCG202S 
25BCC202S 
25BBA202S 
25BFS202S 

 

Applications of Artificial Intelligence 

  

3 

  
3 

Prerequisites Basics of Artificial Intelligence 



 

 
 

 

 

 

 
 

Applicable To Commerce and Management– Semester II 

Syllabus 

 

COURSE CONTENT 

UNIT I 

Infrastructure and Platforms for Building Applications using AI: 

 

Hardware used in building AI applications: Processors - CPU, GPU, TPU, NPU, 

Memory - RAM, VRAM, Storage - HDD, SSD  

Platforms for building applications using AI: Online platforms (Example - Google 

AutoML, H2O.ai; Desktop (No-code/Low code) platforms (Orange Data Mining, 

KNIME.  

Edge AI: Concept; Applications in daily life in devices like Refrigerators, Led Bulbs, 

Surveillance Cameras, Micro Ovens, Smart Cars/Scooters; Edge AI in smart Appliances. 

UNIT II 

Foundations of Data - Types, Ethics and Utility in Building Applications using AI: 

 

Importance of data in building AI applications: Data as the fuel for AI, Role of big 

data in training AI models.  

Conceptual Foundations of Data: Data vs. Information vs. Knowledge.  

Structure of Data: Structured, Semi-Structured, and Unstructured Data.  

Modalities of Data: Text, Image, Audio, Video, Tabular. 

Formats of Data: Text Formats (CSV, JSON, XML), Image Formats (JPEG, GIF, 

PNG), Audio/Video (MP3, WAV, MP4, AVI).  

Data Repositories: Definition of public Datasets; Definition of private Datasets; 

Importance of Public Datasets, Popular Public Dataset Repositories (Example - Kaggle, 

Google Dataset Search or similar ones - for demonstration only), Dataset licensing and 

usage rights.  

Ethics, Privacy in Data Usage: Privacy concerns related to data usage; Ethical use of 

data, Responsible AI data practices. 

UNIT III 

The AI Data Pipeline: From Collection to Model Readiness: 

The AI Data Pipeline: Stages and Components: Key Stages (Data Collection, Annotation, 

Preprocessing, Splitting, Feeding into AI Models  



 

 
 

Core Components: Ingestion, Storage, Processing, Validation, Delivery  

Data Collection Methods for AI: Manual Input (Surveys, forms, human-curated entries), Sensors & 
IoT Devices (Real-time data from physical environments), System Logs & Transactions, Web Scraping 
(Automated extraction from websites), APIs (Structured data access from external platforms)  
Data Annotation and Labelling: Definition & Importance; Annotation Methods: Manual Annotation, 
Automated Annotation;  
 
Data Cleaning and Preprocessing: Importance of data cleaning; Understanding “Dirty” Data: Missing 
Values, Duplicates, Incorrect Formats, Outliers, Noise; Steps in Data Cleaning: Identify Issues, Handle 
Errors (Imputation, Removal), Validate Cleaned Data.  
Data Splitting: Splitting data into training set and test set.  
Data Transformation Techniques: Normalization, Transformation. 

UNIT IV 

AI in Commerce – Transforming the Consumer Experience  

Introduction to AI in Commerce, Recommendation Engines (Collaborative & Content-

Based), Chatbots and Virtual Assistants, Sentiment Analysis and Review Mining, 

Inventory Optimization and Demand Forecasting, Ethical Issues related to use of AI in 

Commerce and Business: Bias, Privacy, and Transparency. 

UNIT V 

AI in Business Operations – Driving Efficiency and Insight: 

AI in Business Intelligence and Predictive Analytics, Financial Applications: Fraud 

Detection, Risk Modelling, HR Applications: Resume Screening, Employee Analytics, 

Supply Chain Automation and Optimization, AI in Marketing: Customer Segmentation, Lead 

Scoring, Strategic Adoption of AI in Enterprises, Explainable AI in E-Commerce. 

 

TEXT BOOKS 

1. 
Data Science for Beginners, Andrew Park (Introductory concepts of data types, collection, cleaning, and 
visualization without coding) 

2. 
AI Basics for Non-Programmers, Tom Taulli (Clear explanations of AI data lifecycle and real-world use 
cases). 

REFERENCE BOOKS 

1. 
Data Preparation for Machine Learning, Jason Brownlee (Conceptual understanding of dataset quality, 
preprocessing, and pipelines). 

2. 
Hands-On Data Science for Non-Programmers, David Meerman Scott  
(Spreadsheet-based data exploration and visualization). 

3. You Look Like a Thing and I Love You – Janelle Shane 

WEB RESOURCES 

1. Kaggle Dataset Search, https://www.kaggle.com/datasets 

2. Google Dataset Search, https://datasetsearch.research.google.com 

3. UCI Machine Learning Repository, https://archive.ics.uci.edu 

4. Hugging Face Datasets, https://huggingface.co/datasets 

5. Open Government Data (India), https://data.gov.in 

https://www.kaggle.com/datasets
https://datasetsearch.research.google.com/
https://archive.ics.uci.edu/
https://huggingface.co/datasets
https://data.gov.in/
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Applicable To Commerce and Management– Semester II 

Model Blue print for the question paper setter 

 

Sl. No. UNIT- Essay 10M Weightage 

1 I 2 20% 

2 II 2 20% 

3 III 2 20% 

4 IV 2 20% 

5 V 2 20% 

  100 100% 

 

 

 

 

 

 
 

 

 

 

 



 

 
 

 

Applicable To Commerce and Management- 

Semester-II 
 

Recommended Format of Question Paper  

Time: 2½Hrs          

 Max. Marks: 70 

Section-A 

Answer any FIVE of the following questions.     5X4=20 
From Contents of Unit-I 
From Contents of Unit-I 
From Contents of Unit -II 
From Contents of Unit -II 
From Contents of Unit -III 
From Contents of Unit -III 
From Contents of Unit -IV 
From Contents of Unit -IV 
From Contents of Unit -V 
From Contents of Unit -V 

Section-B 
Answer FIVE questions.        (5X10=50M) 
A) From Contents of Unit-I 
OR 
B) From Contents of Unit-I 
A) From Contents of Unit-II 
 OR 
B) From Contents of Unit -II 
A) From Contents of Unit -III 
OR 
B) From Contents of Unit -III 
A) From Contents of Unit -IV 
OR 
B) From Contents of Unit -IV 
A) From Contents of Unit -V 
OR 
B) From Contents of Unit –V 
 
 



 

 
 

 

Applications of AI 
Applicable to Commerce and Management 
MODEL QUESTION PAPER(W.E.F2025-2026) 

Time:2½Hrs.                                                                           MaxMarks:50 

Q. No Question Marks BL CO PO P
I 

SECTION – A 

Answer any Five of the Following 5 X 4 = 20M  

1  Explain about any online platform to build AI application. 4M 2 1   

2 State about the Edge AI in smart Appliances. 4M 1 1   

3 Write a short note on “Structure of Data”. 4M 1 2   

4 Explain about Modalities of Data. 4M 2 2   

5 Define the process of Data Annotation and Labelling. 4M 2 3   

6 Discuss about various data collection methods for AI. 4M 2 3   

7 Write short note onSentiment Analysis and Review Mining. 4M 1 4   

8 Discuss about the role of AI in Inventory Optimization and 
Demand Forecasting. 

4M 2 4   

9 Explain the role of AI inHR Applications? 4M 2 5   

10 Illustrate the “Explainable AI in E-Commerce”. 4M 2 5   

 

SECTION – B 

Answer Any five Questions  5 X 10 = 50 M   

1 Explain the hardware components for building AI applications? 
(OR) 
Explain briefly about AI in applications in daily life appliances? 

10M 
 
10M  

2 
 
2 

1 
 
1 

  

2 Explain the importance of data in building AI applications? 
(OR) 
Discuss about data repositories and data licensing in AI? 

10M 
 
10M  

2 
 
2 

2 
 
2 

  

3 Summarize about Stages and Components AI Data Pipeline? 
(OR) 
b) Distinguish between Data Cleaning/Preprocessing    and Data 
Splitting? 

10M 
 
10M  

2 
 
2 

3 
 
3 

  



 

 
 

4 Describe the Ethical Issues in AI Commerce in detail? 
(OR) 
Classify the Chatbots and Virtual Assistants in AI? 

10M 
 
10M  

3 
 
2 

4 
 
4 

  

 5 Explain the various applications of AI Business Intelligence? 
(OR) 
Explain about AI in Marketing? 

10M 
   10M  

2 
 
2 

5 
 
5 

  

 

 
 



 

 
 

 

 

MODEL QUESTION PAPER (W.E.F2025-2026): 

APPLICABLE TO COMMERCE AND MANAGEMENT 
Course Code Title of the Course L T P C 

25BCG202L 
25BCC202L 
25BBA202L 

      25BFS202L 

 

Applications of AI 

   
2 

 
1 

Prerequisites Basic Knowledge in AI 

 

   Practice Session 

Lab Practicals (No Coding) 

Lab 1 - Exploring Public Datasets (Orange Data Mining)  

 ● Visit a public repository (Kaggle, UCI, data.gov.in)  

 ● Download a dataset (e.g., rainfall data, literacy rates, or traffic accident statistics)  

 ● Procedure: 1. Open Orange → Add File widget → Load a CSV (e.g., Titanic dataset). 2. Connect 

to Data Table → View rows/columns. 3. Connect to Data Info → Check attributes, data types. 4. View in 

Data Table and Distributions widget.  

 ● Observation: Note numeric, categorical, missing values.  

 ● Outcome: Students understand structured data format in CSV.  

Lab 2 - Understanding Dataset Metadata and Formats  

 ● Take two datasets in different formats (CSV, JSON)  

 ● View metadata (description, features, size, license)  

 ● Compare domain-specific datasets (e.g., medical vs. finance)  

Lab 3 - Data Annotation Exercise  

 ● Use MakeSense.ai or VGG Image Annotator (VIA)  

 ● Annotate 10 sample images (traffic signs, fruits, or medical scans)  



 

 
 

 ● Export annotations in XML or YOLO format  

 ● Discuss annotation errors and challenges  

Lab 4 - Data Cleaning and Visualization (Orange Data Mining)  

 ● Aim: To clean dirty data and visualize categorical and numeric attributes.  

 ● Procedure: 1. Load dataset. 2. Connect File → Edit Domain (to change types) and Impute (to 

fill missing values). 3. Compare cleaned vs. original in Data Table. 4. Distributions widget. 5. Check 

various features distribution. (Optional: Create simple bar charts/line charts to visualize trends using 

Google Looker Studio) ● Observation: Missing values filled with mean/median., Graphical 

representation of data.  

 ● Outcome: Learn importance of data cleaning., Students learn importance of visualization in 

preprocessing.  

Lab 5: Train/Test Split in Orange  

 ● Aim: To split a dataset for AI training/testing.  

 ● Procedure: 1. Load Titanic dataset. 2. Connect File → Data Sampler (70% train, 30% test). 3. 

Connect outputs to Data Table widgets to view.  

 ● Observation: Students see two different subsets.  

 ● Outcome: Concept of model validation using split data.  

 

 

Lab 6: Introduction to AI in Commerce – Use Case Exploration  

 Prerequisite: Discuss conceptually about Clustering  

 Objective: Understand how AI is applied in commerce through data visualization and clustering. 

Orange Workflow: Use Orange Data Mining Tool  

 Widgets Used: File → Data Table → Scatter Plot → Hierarchical Clustering Dataset: Retail 

customer data (e.g., purchase frequency, amount spent)  

 Dataset Link: Retail Sales Data  

 Activities: · · · Load customer data and visualize spending patterns. Apply clustering to identify 

customer segments. Discuss how businesses can tailor services to each segment.  

 Outcome: Students grasp how AI helps businesses understand and target consumers more 

effectively.  

Lab 7: Recommendation Engine Simulation  

Prerequisite: Discuss conceptually about Clustering  



 

 
 

Objective: Simulate collaborative filtering using similarity-based clustering.  

Orange Workflow:  

Widgets Used: File → Distance → Hierarchical Clustering → Data Table  

Dataset: User-product ratings matrix  

Dataset Link: Amazon Product Recommendation System  

Activities:  

● Calculate similarity between users.  

● Group similar users and recommend products based on cluster behavior.  

● Discuss differences between collaborative and content-based filtering.  

Outcome: Students understand the logic behind recommendation systems and how they  

personalize user experience.  

Lab 8: Chatbot Intent Classification  

Prerequisite: Discuss conceptually about Linear Regression & Logistic Regression  

Objective: Train a model to classify customer queries into intents.  

Orange Workflow:  

Widgets Used: File → Preprocess Text → Bag of Words → Logistic Regression → Test & 

Score  

Dataset: Sample customer queries labeled with intents (e.g., “track order”, “return item”)  

Dataset Link: Customer Intent Classification  

Activities:  

● Preprocess and vectorize text data.  

● Train a classifier to predict query intent.  

● Evaluate accuracy and discuss chatbot training.  

Outcome: Students learn how AI understands and responds to customer queries.  

Lab 9: Sentiment Analysis of Reviews  

Prerequisite: Discuss conceptually about Naive Bayes  

Objective: Classify customer reviews as positive or negative.  

Orange Workflow:  

Widgets Used: File → Preprocess Text → Bag of Words → Naive Bayes → Test & Score  

Dataset: Product reviews with sentiment labels  

Dataset Link: Amazon Product Reviews – Sentiment Analysis  

Activities:  



 

 
 

● Clean and tokenize review text.  

● Train a sentiment classifier.  

● Visualize word clouds for positive vs. negative reviews.  

Outcome: Students analyze customer feedback and extract actionable insights.  

Lab 10: Demand Forecasting with Regression  

Prerequisite: Discuss conceptually about Linear Regression & Logistic Regression  

Objective: Predict future sales using regression models.  

Orange Workflow:  

Widgets Used: File → Linear Regression → Scatter Plot → Test & Score    

Dataset: Historical sales data (e.g., monthly sales, promotions)  

Dataset Link: Comprehensive Retail Sales Data  

Activities:  

● Train a regression model to forecast sales.  

● Visualize predictions vs. actuals.  

● Discuss implications for inventory planning.  

Outcome: Students understand how AI supports demand forecasting and inventory control.  

Lab 11: Bias Detection in AI Models  

Prerequisite: Discuss conceptually about Linear Regression, Logistic Regression & Confusion  

Matrix  

Objective: Explore bias in predictive models and its impact.  

Orange Workflow:  

Widgets Used: File → Logistic Regression → Confusion Matrix → Distributions   

Dataset: HR hiring data with gender or age attributes  

Dataset Link: HR Data Analytics  

Activities:  

● Train a model to predict hiring decisions.  

● Analyze performance across demographic groups.  

● Discuss fairness, transparency, and ethical implications.  

Outcome: Students critically assess bias and propose ethical safeguards.  

Lab 12: Predictive Analytics for Business Intelligence  

Prerequisite: Discuss conceptually about Random Forest  

Objective: Use classification to predict customer churn.  



 

 
 

Orange Workflow:  

Widgets Used: File → Random Forest → Test & Score → ROC Analysis  

Dataset: Telecom or subscription data with churn labels  

Dataset Link: Telco Customer Churn – IBM Dataset  

Activities:  

● Train and evaluate a churn prediction model.  

● Interpret ROC curves and accuracy.  

● Discuss how businesses can act on predictions.  

Outcome: Students apply predictive analytics to improve customer retention.  

 

Lab 13: AI in HR and Marketing – Resume Screening & Segmentation  

Prerequisite: Discuss conceptually about Clustering  

Objective: Classify resumes and segment customers using clustering.  

Orange Workflow:  

HR Task: File → Preprocess Text → Bag of Words → Logistic Regression  

Marketing Task: File → k-Means Clustering → Scatter Plot   

Resume Screening Dataset: Employee Hiring Data  

Customer Segmentation Dataset: Customer Segmentation Dataset  

Activities:  

● Screen resumes based on job fit.  

● Segment customers by behavior or demographics.  

● Discuss automation benefits and risks.  

Outcome: Students explore how AI enhances HR and marketing efficiency.  

Note: The Tools suggested above are tentative. Teacher/Student is free to choose any other  

similar tool to execute the said lab experiments. 
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EVALUATION SCHEME 

Standard Operating Procedure for Continuous Internal Assessment  (Internal Marks – 30). The 

Internal marks in all the courses/subjects will be awarded based on continuous internal 

assessment made during the semester concerned. For each Courses/subject 30 marks are 

allotted for internal assessment and 70 marks are allotted for the End Semester Examination. 

Continuous Internal Evaluation (CIA): 

It has been decided to introduce Continuous Internal assessment marks for a total of 60 marks, 

which are to be distributed as follows: 

 

The Total 60 Marks is scaled down to 30 Marks* 

 

 

S.No. Component Distribution of Marks 

1 CIE - I(off line Exam after completion of 50% of syllabus) 20 

2 CIE - II(off line Exam) 20 

3 Attendance 5 

Pedagogical Strategies  

4 Assignment 5 

5 Participation or Paper Presentation by Student 

Seminars/Workshops/Group Discussions/Quiz/Student Study 

Project/Field Visit/Survey 

5 

6 Swatch Bharat (Clean & Green) 5 

TOTAL 60 



 

 
 

Component I: CIE - I &CIE - II(20+20 =40 Marks) 

Two Internal Examinations, shall be conducted for assessment. These examinations will be 

conducted during August/September (CIE –I) and January/February (CIE-II). CIE-I carries 20 

marks and CIE-II carries 20 marks. CIE- I will be conducted after completion of 50% of 

syllabus. The second internal examination, i.e., CIE– II, which will cover the remaining second 

half of the syllabus. The sum of both the CIEs will be considered for awarding marks for CIA 

Component - III: Attendance (5 Marks) 

Attendance mark will be awarded to the students based on their attendance percentage on a       

particular course. Faculty of each course has to award the attendance mark based on their         

subject attendance. 

Component - IV: Assignment (5 Marks) 

One Assignment for each course must be submitted by a student in each semester. The marks 

allotted to this component will be awarded based on the performance of the student. The 

assignment topic may be assigned either individually or group. Assignment should be submitted 

by the student in the first half of the semester. Also maximum of 7 days should be given to 

students to submit the assignment. Assignments should be evaluated by the faculty concerned 

and the same to be verified by the student. The assignment should be kept in department for the 

Academic Audit by IQAC and also for external academic audit conducted by office of 

Commissionerate of Collegiate Education. The marks should be awarded by the faculty. 

Component- V( Pedagogical Strategies): 

Participation /Paper Presentation in Student Seminars/Workshops/Group Discussions/ Quiz/ 

Student Study Project/Field Visit/Survey (5 Marks). 

For this component, the marks will be provided to student, if he/she participate/win in the 

external college technical events. To score marks, the student has to participate/present papers 

related to Subject in the technical events organized in the  other  colleges/other departments in 

the college. 

In case of Classroom seminar, one seminar for each course must be presented by a student in 

each semester. Each student should be given individual topic for seminar; the student has to 

submit the seminar topic as assignment and the same will be presented minimum of 10 minutes 

in the class through ICT. The seminar presented by the student should be evaluated by the 

subject faculty and Based on the performance of the presentation, the marks will be awarded. 



 

 
 

Similarly, reports on field visits, educational tours, study projects in prescribed format will be 

considered for awarding marks in this component. 

In case of Quiz, offline/online quiz, it should be conducted after the CIE II and well before the 

SEE. Faculty concerned has to announce the schedule for the quiz and conduct the quiz.  

 Semester End Examinations (SEE) 

The question paper is of 3 hrs duration for 70 marks. The suggestive question paper model is 

given that may be used for framing the question.  
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Academic Schedule: 2025-26 
UG Programmes ( Semester – I ) 

 

 

1. 
Commencement of regular class work for UG - 

Semester - I 
22-09-2025  

2. Dasara Vacation 28-09-2025 to 05-10-2025  

3. Mid - Term I Examinations 24-11-2025 to 29-11-2025  

4. Mid - Term II Examinations 02-01-2026 to 07-01-2026 

5. Pongal vacations 10-01-26 to 18-01-2026 

6. Closure Of Instructions 22-01-2026 

7. Practical Examinations 23-01-2026 to 24-01-26 

8. Semester end Examination 27-01-2026 to 03-02-2026 

 

Month wise working days for Semester - I 

Month September 
22-09-2025 

October 
2025 

November 
2025 

 

December 
2025 

January 
22-01- 2026 

Total 

Total Days 06 31 30 31 29 127 

Number of 

Holiday 

- 11 06 06 14 37 

Number of 

Working Days 

06 20 24 25 15 90 

 

Academic coordinator                 Controller of Examination                          Principal 



 

 
 

 

Academic Schedule: 2025-26 
UG Programmes (II Semester) 

1. 
Commencement of Regular class work 

for UG - Semester - II 
05-02-2026  

2. Mid - Term I Examinations 09- 03-2026  to 13-03-2026 

3.  Summer Vacation 01-05-2026 to 31-05 -2026 

4 Re opening 01-06-2026 

5. Mid - Term II Examinations 15-06-2026 to 22- 06 -2026 

6. Closure Of Instructions 03-07-2026 

7. Semester end Examination     06 - 07-2026 to  14 -07-2026 

8. Practical Examinations 15-07-2026 to 16-07-2026 

9. 
Commencement of III Semester Class 

work 
17-07-2026 

 

Month wise working days for Semester - II 

Month February 
05-02-2025 

March 
2025 

April 
2025 

 

May 
2025 

June 
01-06- 2026 

Total 

Total Days 24 31 30 31 30 146 

Number of 

Holiday 

05 08 06 31 06 56 

Number of 

Working Days 

19 22 24 0 24 90 

 

Academic Coordinator                                 Controller of Examination                             Principal 
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